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Guidance on Content 
The accompanying template is provided as a way for public water systems (PWS) that don’t have 
a lot of time or resources to more easily develop a CCR that (1) meets all federal requirements; 
(2) is fairly easy for the PWS to create; and (3) enhances the consumer’s understanding of their 
water quality, more so than the current CCR. 
 
The template was developed in concert with an advisory committee comprising a cross section of 
professionals in the sector, including representatives from public water systems, AWWA, private 
water systems, regulatory agencies, and nonprofits.  
 
Every effort has been made to ensure this template complies with all regulations, but each public 
water system should check the federal guidance and any specific guidance from their 
state, to make sure their CCR meets the requirement. 
 
There is no one-size-fits-all CCR template. Some PWS choose to only mail their CCRs to 
customers, while others prefer to only have a website. Yet others prefer to do both. 
 
This template offers you two versions: a Word document and a Squarespace website.  
 
The Word document can be printed and mailed (in an envelope) or provided as a link to a PDF 
document at the PWS’ website (satisfying the one-click requirement). For the PWSs who don’t 
mail their CCR, and only provide it as a PDF linked to their website, it could be printed and mailed 
to customers upon request. We highly recommend the PDF link be prominently displayed on the 
PWS home page AND a water quality page (if one exists).  
 
Check with your regulator, but most PWS are not required to mail their CCR, but all PWS need to 
make sure every customer is notified of its existence and how to access it. To satisfy this 
requirement, PWS may send a letter or postcard, print the notice on the customers’ bill, or 
provide a bill insert to each customer. No matter the communication channel, the notice must 
indicate the availability of the report at the PWS’ website and provides the “one click” link. Some 
recommended content ideas for that letter, postcard or bill insert are: 
• A personal letter from the system leader that summarizes the findings and invites customers to 

attend board meetings, have a tour of the plant, or follow you on social media. 
• Sharing that your top priority is making sure that the water customers use to drink, wash your 

hands, bathe your children, and prepare healthy meals meets all state and federal drinking 
water standards. 

• How many tests you perform each year to assure the safety of the water. 
• Infographics that share # samples collected, # tests performed # substances monitored. 
• Perhaps include a brief table of some key substances, such as bacteria, lead, fluoride, and 

disinfection byproducts.   
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Additional and Optional Content 
We have provided all the sections that are typically required for all PWS as well as a “Additional 
Content” section for those who experience a violation and an “Optional Content” section for those 
who want to provide more information than is required. Just be aware this will create more pages 
to print and mail if that’s what you’re planning to do.    
 

Consecutive Systems 
We know that many PWSs purchase water from other systems, many sell water to another 
system, and there are those that both purchase and sell water. These systems all need to share 
data that need to be included in CCRs. Our advice here is to keep it all within the same table and 
identify the source in the column marked “source of water”.  
 

Data Tables 
We have made some updates to the table to make it a little more “reader-friendly” and to put the 
data in better context, we’re offering you a design element that will enable you to highlight a few 
substances outside of the table. These are your choice – they can be substances you pay close 
attention to, ones for which you had violations, or ones that you just know your customers care 
about most. The table of data itself follows with some annotations to help the reader through. 
Don’t forget that if you have a violation, or require additional monitoring by your regulator, you 
need to consult the section on additional information for the required language.  
 

Resources to Consult 
The team that developed this template consulted many resources to be sure we incorporated the 
latest suggestions talked about within the sector conversations about the CCR. Here is a list of 
those resources we consulted. Note there is a lot of support for changing the actual language, 
however, at this time, the language provided (with the exception of optional text) is required 
language.  
 
• Journal AWWA Article: Putting Better Water Quality Communication on the Fast Track – 

November 2021 
• Consumer Confidence Report Rule Revision Working Group Report to National Drinking Water 

Advisory Council – November 2021 
• AWWA Letter to EPA: CCR3 Working Group Report Public Meeting, Post-meeting Comments – 

November 2021 
• AWWA Letter to EPA: CCR3 Working Group Report Public Meeting – October 2021 
• Utilities Policy Paper: Poor accessibility of water utilities’ consumer confidence reports – July 

2021 
• 2020 Water Data Prize Recommendations – March 2021 
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• Utilities Policy Paper: Utility approaches to evaluating the effectiveness of consumer confidence 
reports – June 2019  

 

Federal Requirements  
For your reference we have included a checklist below of all required information, per the Safe 
Drinking Water Act1. These are sections you will find in the template. 
Water System Information 

a. Name/phone number of a contact person 
b. information on public participation opportunities  

2. Source(s) of Water 
a. Location 
b. Common name 
c. SWDAR availability, water source susceptibility and potential sources of 

contamination 
3. Definitions 

a. Maximum Contaminant Level (MCL)/MCL Goal (MCLG) 
b. Treatment Technique (TT) 
c. Action Level (AL) 
d. Maximum Residual Disinfectant Level (MRDL)/MRDL Goal (MRDLG) 

4. Detected Contaminants  
a. A table summarizing reported concentrations and relevant MCLs and MCLGs or 

MRDLs and MRDLGs 
i. Known source of detected contaminants 
ii. Health effects language 

5. Information on Monitoring  
a. Cryptosporidium 
b. Radon 
c. Other contaminants (if detected).  

6. Compliance with Other Drinking Water Regulations  
a. Any violations and Ground Water Rule [GWR] special notices  

7. Variances and Exemptions  
a. If applicable 

8. Required Educational Information  
a. Explanation of contaminants in drinking water and bottled water 
b. Information to vulnerable populations about Cryptosporidium 
c. Statements on  

i. Nitrate 
ii. Arsenic 
iii. Lead (see Lead and Copper Rule Revision CCR Requirements, page 150) 

 
1 Consumer Confidence Report Rule: A Quick Reference Guide (epa.gov) 

https://www.epa.gov/sites/default/files/2020-12/documents/lcrr_prepublicationnotice_frl-10019-23-ow.final_.pdf
https://www.epa.gov/sites/default/files/2014-05/documents/guide_qrg_ccr_2011.pdf
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1. Updated health effects information 
2. How to access lead service line inventory 
3. How to access all tap sampling results shown in the CCR 

 
Further, America’s Water Infrastructure Act of 2018 (still to be implemented by the EPA) amends 
the Safe Drinking Water Act to require CCRs contain information about: 
• Corrosion control efforts 
• Identify lead action level exceedances for which corrective actions were required 
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Word Document Report Template  
Part 1: Update Colors and Fonts to Your Branding 

Change Colors: For ease of readability and flow, it is recommended to have at least 
the header title a different color than black. 

1. Go to the Design tab at the top, then click the Colors. See screenshot below. 

 
 

2. At the bottom of the drop-down menu there is a Customize Colors option for you to insert 
your brand colors. You can also choose any of the Office preset colors. If you choose to 
stay with the CCR Template colors but would like to change the blue color used throughout, 
right click on the palette and select Edit. When you update Text Background – Dark 2, that 
will automatically update everything that is currently blue in the template. 

 
Change Fonts: For ease of readability and flow, it is recommended to have at least 
the header title set as bold text. 

1. To update the fonts, follow the same two steps as changing the colors. See screenshot 
below.  

 
 

2. At the bottom of the drop-down menu there is a Customize Font option for you to choose 
the font of your preference. You can also choose any of the Office preset fonts. 
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3. An alternative option to the first two steps are to update the paragraph Styles by right 
clicking on the style (i.e., Body), and then click Modify.  

 
4. A window will pop up where you can change the font, size, bold, paragraph options, etc.  
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Part 2: Update Content 

General 
1. It’s up to you to make sure that the information in your CCR is correct and includes all the 

required language. There are comments throughout the template indicating the language 
that’s required by regulators; however, regulators in your state may have specific 
requirements, so make sure to check with your regulators to ensure compliance.  

2. Throughout the template, we have included optional text that will enhance the consumer’s 
understanding of their water quality. You can remove, add to, or change the optional text at 
your discretion and as it makes sense for your utility and consumers. 

3. Update all highlighted items with your utility’s information. 
4. All the photos that have been included in the template can be used in your CCR as they are 

free for commercial use; however, we recommend replacing the photos with ones that best 
represent your community. To replace a photo, right click on the photo and select Change 
Picture. 

 
Cover Page  
Delete the logo placeholder box and add your logo instead by going to the Insert tab and 
selecting Pictures. Right-click on the picture to change the Wrap Text option to “In Front of Text” 
and “Fix position on page.” 
 
Message From Your Leader 
A headshot photo is included as a placeholder to show a layout option if you would like to include 
one. If you don’t want to include the photo, simply select delete it.  
 
About Your Water 
This is a section devoted to where your water comes from, so you want to describe the source (or 
sources) and share an image if available. There is also some required text so be sure to keep 
that as is.  
 
Your Water Data 

1. This section provides an opportunity to share a quick overview of what you tested for, how 
often, and whether your water meets all standards. Note this is the main thing a consumer 
will want to know, so make it very clear. If desired, you could talk about your sampling 
protocol and explain that you test for both regulated and unregulated substances (if that’s 
the case). 

2. We also provide four “mini” tables which give you a chance to highlight up to four 
substances. Your choice which ones to pick. You can delete one or two or all of them if you 
don’t like this. The main table of data will be at the end, and there’s a place for you to insert 
a page number of where they can flip to it.  

3. All of the tables are set up as placeholders for typical substances sampled and should be 
updated with actual data of substances sampled for the year. 
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4. Update the abbreviation definitions following each table to include the abbreviations used in 
that table. 

 
Table of Water Data for 20XX 

1. This section is where the standard table of data is provided. The formatting is intended to be 
easier on the eyes and meet ADA compliance.  

2. All of the tables are set up as placeholders for typical substances sampled and should be 
updated with actual data of substances sampled for the year. 

3. Update the abbreviation definitions following each table to include the abbreviations used in 
that table. 

 
En Español (Spanish translation) 
We have included text in Spanish that informs consumers where they can get a version of the 
CCR in Spanish. This text in Spanish that we have included translates to:  

“This report includes important information about drinking water. If you have questions or 
comments about this report in Spanish, please contact us by email at [email] or by phone at 
[phone].” 

 
Appendix: Additional Required Language if Applicable 
This section is not intended to be part of the report, but instead for you to copy and paste into the 
appropriate sections if it applies to your utility. Delete the Appendix once you finalize the 
report.  
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Part 3: Ensure ADA Compliance 
The template is ADA compliant; however, the changes that you make to the document can 
impact the document’s ADA compliance. Please review the final document for ADA compliance. 
This section summarizes a few of the ways to make your report accessible to people with 
disabilities. For more information to meet the guidelines, visit https://www.w3.org/WAI/standards-
guidelines/wcag/.  
 

1. Add “Alt Text” to describe each image and icon  
a. Right-click on an image or icon and select Edit Alt Text 
b. Add text into the description field and mark as decorative if necessary 

2. Colors and contrast 
a. Make sure to use sufficient contrast for text and background colors 
b. To check whether the colors you’ve used are compliant, you can test them here: 

https://webaim.org/resources/contrastchecker/ 
3. Font size 

a. The font size should make it easy for the text to be effectively displayed on all 
devices, including mobile, desktop, tablets, and special devices like screen readers. 

b. Headings should feature larger text compared to the body text. 
4. Tables  

a. It’s better for readability to create individual tables than one big table with multiple 
headers. 

b. Make sure the header row is always checked under the Table Design tab. 
c. Make sure header rows are repeated if the table flows onto the next page by 

selecting the table, going to the Layout tab at the top of the Word window, and 
selecting Repeat Header Rows in the Data section 

5. Make sure all of the text in the report is associated with a paragraph style and headers are 
used (can use up to six headers) 

6. Hyperlinks need to be clearly underlined, stylized, pointed out, and ScreenTip is added 
a. To add ScreenTip description, right click on the hyperlink and select Edit Hyperlink 
b. ScreenTip will appear on the right side 

7. Make sure to add bookmarks by going to the Acrobat tab and then selecting Preferences. 
Make sure Create Bookmarks is checked. 

8. Use the Accessibility Checker feature by going to the Review tab, select the Check 
Accessibility dropdown menu, then select Check Accessibility. 

9. When exporting to PDF, you can use CommonLook to check the document’s accessibility: 
https://commonlook.com/best-pdf-validator-is-free-for-everyone/ 

  

https://www.w3.org/WAI/standards-guidelines/wcag/
https://www.w3.org/WAI/standards-guidelines/wcag/
https://webaim.org/resources/contrastchecker/
https://commonlook.com/best-pdf-validator-is-free-for-everyone/
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Squarespace Website Template  
Part 1: How to Set Up an Account 

• Visit https://www.squarespace.com/ 
• Select Log In at the top right 
• Then select Create Account at the top right again 
 
Your costs are composed of two parts, the cost to have a Squarespace account, and the cost 
associated with hosting the site. 
 
Account Type and Cost 
Below we have provided two different account options for you to decide what best fits your needs. 

• Personal Account – Recommend if you are looking for a basic account just for the CCR  
o Annually $14/month 
o Monthly $19/month 

• Business Account – If you would like more advanced marketing features (analytics, 
promotional pop-ups, etc.)  

o Annually $23/month 
o Monthly $33/month 

• For detailed information on the various types of plans, including pricing and features, visit 
https://www.squarespace.com/pricing/ 

 
Domain Information and Cost 
A domain is the name of your website and serves as the URL address people will use to access  
the website (i.e., www.utility.waterqualityreport.com). 

• If you pay for your Squarespace site on an annual basis, Squarespace gives you one year 
of free domain registration on their cheapest pricing tier. 

• If you would like to register for a domain on Squarespace, view this video: 
https://youtu.be/dl4niwlFppo?t=52  

• If you would like to transfer a current domain that you own from a third-party site (i.e. 
GoDaddy), view this video: https://www.youtube.com/watch?v=hc5Gf9TW-zQ 

• If you do not want to pay for a custom domain and prefer not to go through a process to 
registering for a custom domain, Squarespace will generate a domain for you automatically.  

• For more information visit https://www.squarespace.com/domain-name-search 
 

  

https://www.squarespace.com/
https://www.squarespace.com/pricing/
https://youtu.be/dl4niwlFppo?t=52
https://www.youtube.com/watch?v=hc5Gf9TW-zQ
https://www.squarespace.com/domain-name-search
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Part 2: How to Access the template 

• Please contact ccrtemplate@raftelis.com for the template and provide the email to which the 
account is registered under. 

• You will then be invited as a contributor, and then the template will transfer to your ownership.  
• After the template is transferred it will show up under your account dashboard, and you can 

start inserting your content. 
 

Part 3: How to Update Fonts and Colors to Match Your 
Brand (if applicable) 

If You Want to Update the Font 
1. In the Squarespace menu on the left, choose Design, then Site Styles.  
2. A menu will appear on the right, where you can select Fonts. Within this menu, there are 

two ways of changing the fonts: 
a. Font Pack  

i. Font Pack is the first option at the top, and to view the fonts select Switch 
ii. You will see three different tabs with different font styles 
iii. Whichever you select will automatically update the fonts in one click 

 
How to Update Fonts using Font Pack  

 
b. Global Text Styles (view tutorial on the next page) 

i. This option is located under font packs, and this option allows you to have 
more flexibility to choose specific fonts 

ii. Select the category (Headings, Paragraphs, etc.) and then select Family 
iii. Select Browse All Fonts and search the font of your choice 
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How to Update Fonts using Global Text Styles  

 
If You Want to Update the Colors 

1. In the Squarespace menu on the left, choose Design, then Site Styles.  
2. A menu will appear on the right, where you can select Colors, then Edit Palette. Within this 

menu, there are a couple of ways to update your colors: 
a. Easiest option to update the colors to match your brand is to use the From Image  

i. Select From Image tab, and then it will prompt you to upload an image, such 
as a logo 

 
How to Update Colors from Image 
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b. If your agency doesn’t have an official color palette, you can choose from the built-in 
color using the Presets option (view tutorial on the next page) 

 
How to Update Colors from Presets 

 
c. If you are fine with the colors of the template but would only like to change the blue, 

you can simply update the color in the color swatch option at the top (view tutorial 
on the next page) 

 
How to Update Fonts using Color Swatch 
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Once you update the colors, the themes will update. The themes serve as a tool if you want to 
change the color backgrounds for each section of the webpage.  

1. When you hover over a section, and editing panel on the top right will appear, and you will 
select the pencil icon 

2. Select the Color tab, and there will be different theme options, ranging from lightest to 
darkest 

 
How to Update Themes 
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Part 4: How to Update Content 

General 
1. It’s up to you to make sure that the information in your CCR is correct and includes all the 

required language. There are comments throughout the word report template indicating 
the elements and language that’s required by regulators; however, regulators in your 
state may have specific requirements, so make sure to check with your regulators to ensure 
compliance.  

2. In the word report template, we provided an Appendix that includes additional required 
language if applicable. 

3. Update all the text that is in brackets with your utility’s information. 
4. If applicable, double check that all the text included in the Word report version is included on 

the website as well. 
5. All the photos that have been included in the template can be used in your CCR as they are 

free for commercial use; however, we recommend replacing the photos with ones that best 
represent your community. If you replace photos, make sure you comply with copyright 
laws. 

6. For every photo used on your website, make sure to add a description in “IMAGE ALT 
TEXT,” which is shown in the videos under the “Message from Your Leader” and “About 
Your Water” sections. This ensures your images are “readable” by those with sight 
impairments and adds to your website’s compliance with ADA. 

7. When you want to make any changes to the webpage, click Edit on the top left and editing 
mode will activate. 

8. Please keep in mind that after you make any changes to the content on your site, you must 
select Done at the top left and Save to exit the editing mode for changes to be live. 

9. To exit the webpage and return to the Account Dashboard, click the Squarespace icon on 
the top left. 

 
How to Add Your Logo 

1. Enter editing mode and at the top of the page select Edit Site Header 
2. A panel will pop up to the right, and you will select Site title & logo 
3. Under logo image select Replace and upload from your file 
4. Logo will appear on the top left of the page 
5. Above the logo image upload, you can rename the site title. If you do not want to include a 

logo the site title will appear instead.  
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How to Add Your Logo 

 
 
How to Update Header Text and Image 

1. Want to update the text? Click the text box and update the text 
2. Want to update the image? When you hover over the image an editing panel will pop up 

on the top right 
a. Select the pencil icon 
b. Select Background and under image select replace 

i. You can upload from your file or chose from free stock images 
 
How to Update Header Section Text and Image 
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Message from Your Leader 
1. Want to update the text? Select into the text box and update all text in brackets to your 

utility’s information 
2. Want to update the image? Select the image and select the pencil icon 

a. Select replace and upload from your file 
b. Add a description under Image Alt Text 
c. If you would like to delete the image, select the image and select the trash can icon 

 
How to Update Message from Your Leader Text and Image 

 
3. Want to remove this section? Hover over the section and select the trash icon on the top 

left 
 
How to Remove Message from Your Leader 
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Download a Print-friendly Version of this Report 
We recommend you set up a webpage at your agency’s website that’s dedicated to water quality. 
It’s here that you could include any more in-depth information you want about source water 
protection, the customer role, etc.  
 
Insert a link to the current Squarespace site on this page to guide viewers to the most recent 
report. All archived CCRs should be listed below that as PDFs of the Word document, with 
filenames that identify them by year. 
 

1. Want to include a link to the print version? Select the button and then a pencil icon will 
appear 

a. Copy in a link to where the print copy is stored, for example your website. 
 
How to Add the Link 

 
 
About Your Water 

1. Where Your Drinking Water Comes From and We Protect the Source are required 
elements and content may be adjusted. 

2. What is in Your Drinking Water includes required language and must be verbatim. 
3. Sampling and Testing, Bacteria, Disinfection By-products, and Lead and Copper are 

required if applicable. 
4. Want to update the text? Select into the text box and update all text in brackets to your 

utility’s information 
a. To delete any text, highlight text and hit backspace or just hit backspace 

5. Want to update the images? Select the image and select the pencil icon 
a. Select replace and upload from your file 
b. Add a description under Image Alt Text 
c. If you would like to delete the image, select the image, and select the trash can icon 
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How to Update About Your Water Text and Image 

 
 
Your Water Meets All (Most) Standards 

1. Adjust the Section header so that it says either, “Your Water Meets All Standards” or 
“Your Water Meets Most Standards” 

2. If your water data meets most standards, include the paragraph listed under [If “most” 
standards are met is applicable include the paragraph below] and delete this sentence 
in the bracket. You can remove if this is not applicable. 

3. Update text in the brackets in the table introductions 
4. All of the tables are set up as placeholders and should be replaced with actual data of 

substances sampled for the year. 
5. You can input data into the table manually or by importing data from either Microsoft 

Excel or Google Sheets. 
6. If you are importing from Microsoft Excel, make sure the file you are uploading is saved as 

a .csv file.  
7. An example template of how to set up a table format for upload is shown here: 

https://www.dropbox.com/s/45acva1wh6zmtej/Lead%20and%20Copper.csv?dl=0   
8. Update the Definitions, if needed, below each table. 

 

https://www.dropbox.com/s/45acva1wh6zmtej/Lead%20and%20Copper.csv?dl=0


 
Consumer Confidence Report Template Instructions Manual 20 
 
 

 

Importing a Table from Microsoft Excel 
1. Select the table and a pencil icon will appear 
2. Table menu will pop up and scroll down to IMPORT *.CSV and select the import button 
3. Once you select the file the data table be inserted  
4. Keep in mind that the data imported will not auto-update. If you update your data within 

Excel, you will need to import the table again 
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Importing a Table from Google Sheets 
1. First step is to generate a link from your Google Sheets 

a. In Google Sheets select File at the top 
i. Under file you will select Share, and then publish to web 
ii. A link will generate for web page, and then you will copy the link 

2. Going back to the webpage, select the table and a pencil icon will appear 
3. Table menu will pop up and scroll down to Paste your public Google Spreadsheet URL 

or key and paste in the link from google sheets 
4. Once it’s pasted in the data table will be inserted 
5. Make sure you check Sync Google Spreadsheet if you make changes to the Google Sheet 

and would like it to auto-update within the table. 
 

  



 
Consumer Confidence Report Template Instructions Manual 22 
 
 

 

Creating a Table Manually 
1. If you would like to add in more tables, whoever you would like to insert it hover over the 

section and a line with a plus sign will appear 
2. Select it and a menu bar will pop up. Scroll down to where it shows the Table option 
3. A generic table will populate. Select the table and select the pencil icon 
4. Scroll down to the bottom where it says Table Data, and you can edit the information. You 

can also add rows and column by selecting the plus sign 
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How to Edit the Colors of the Table 
1. Select the table and a pencil icon will appear 
2. You will see the option to change the background color, header background color, header 

text color, body color, and borders color 
3. Select the color block on the right and a color swatch will pop up 
4. If you need to upload a new file, the upload will not change any formatting edits you made 

 
When you upload the tables, it will not carry over any color formatting that make within the excel 
or google sheets file. If you would like to edit the colors of the rows and columns background or 
fonts, you can do so by editing within the table dialog box. 

 
Stay Informed About Your Water 

1. Monthly Board Meetings is a required element and content may be adjusted. 
2. Contact Information is a required element and content may be adjusted. 
3. Want to update the text? Select into the text box and update all text in brackets to your 

utility’s information 
a. To delete any text box, select the box and select the trash can icon 

4. Want to update the images? Select the image and select the pencil icon 
a. Select replace and upload from your file 
b. Add a description under Image Alt Text 
c. If you would like to delete the image, select the image, and select the trash can icon 

5. Want to delete the line? Select the line and select the trash can icon. 
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How to Update Stay informed About Your Water Text and Image 

 
 
Your Role in Water Quality 

1. Certain text associated with Check Your Home or Business’ Plumbing for Lead and 
Copper includes required language and must be verbatim. Please view the Word report 
template for what is required 

2. Look Out for Special Populations includes required language and must be verbatim. 
3. Definitions is a required element. Include definitions for MCLG and MCL. Also include any 

other acronym and definitions that are included in your CCR. 
4. Want to update the text? Select into the text box and update all text in brackets to your 

utility’s information 
a. To delete any text box, select the box and select the trash can icon 

5. Want to update the images? Select the image and select the pencil icon 
a. Select replace and upload from your file 
b. Add a description under Image Alt Text 
c. If you would like to delete the image, select the image, and select the trash can icon 

6. Want to delete the line? Select the line and select the trash can icon. 
 
For a tutorial on how to make these changes please view How to Update Stay informed About 
Your Water Text and Image. 
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Updating the Contact Section 
You may want to include a way for your customers to get in touch with you. If so, use this contact 
form. It will allow you to designate an email address at your organization for these questions and 
comments to get to the right person.  

1. Update the contact information to the left of the form by clicking into the text box 
2. To update the contact form to include who the message will be sent to, select the Form and 

select the pencil icon 
a. Select the Storage tab, and under Email enter the email address 

3. If you don’t want to include this section, select the Contact section, and select the trash can 
icon to delete it. 

 
How to the Contact Section 
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Footer Section 
1. At the bottom select Edit Footer 
2. Update Company Name to the utility’s name 
3. Add in contact information that are applicable, such as address, phone number, email, and 

website. 
 
How to the Footer Section 
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Part 5: How to Share Your Website Privately or Publish for 
Public Viewing 

How to Share Your Website Privately 
1. In the Squarespace menu on the left, select Settings, then select Site Availability 
2. Select Password Protected, and enter the password 
3. When you share the website link you will also provide the password 

  
How to Publish Your Website 

1. In the Squarespace menu on the left, select Settings, then select Site Availability 
2. Select Upgrade to Publish 
3. If you have not paid for an account yet, it will prompt you to pay for one 

 
How to Update the Website Each Year with New Data and Archive Old Data 
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Want to update your webpage with the new data and archive your previous data privately? 
1. In the Squarespace menu on the left, select Pages 
2. Under Not Linked, you will see a page labeled 2021 Data. That is the page that you are 

currently showing live 
3. To duplicate the page select the gear icon on the left as you have the page selected 
4. A menu will pop up and you will select General. Scroll down and there will be a Duplicate 

Page button  
5. To rename the duplicate page, go back to General, and rename Page Title and Navigation 

Title. The duplicate page can be served as new data or previous data 
6. Keep in mind that whatever page is selected will be shown live. Other pages not shown will 

be hidden 
 

 
 


	Guidance on Content
	Additional and Optional Content
	Consecutive Systems
	Data Tables
	Resources to Consult
	Federal Requirements

	Word Document Report Template
	Part 1: Update Colors and Fonts to Your Branding
	Change Colors: For ease of readability and flow, it is recommended to have at least the header title a different color than black.
	Change Fonts: For ease of readability and flow, it is recommended to have at least the header title set as bold text.

	Part 2: Update Content
	General
	Cover Page
	Message From Your Leader
	About Your Water
	Your Water Data
	Table of Water Data for 20XX
	En Español (Spanish translation)
	Appendix: Additional Required Language if Applicable

	Part 3: Ensure ADA Compliance

	Squarespace Website Template
	Part 1: How to Set Up an Account
	Your costs are composed of two parts, the cost to have a Squarespace account, and the cost associated with hosting the site.
	Account Type and Cost
	Domain Information and Cost

	Part 2: How to Access the template
	Part 3: How to Update Fonts and Colors to Match Your Brand (if applicable)
	If You Want to Update the Font
	If You Want to Update the Colors

	Part 4: How to Update Content
	General
	How to Add Your Logo
	How to Update Header Text and Image
	Message from Your Leader
	Download a Print-friendly Version of this Report
	About Your Water
	Your Water Meets All (Most) Standards
	Stay Informed About Your Water
	Your Role in Water Quality
	Updating the Contact Section
	Footer Section

	Part 5: How to Share Your Website Privately or Publish for Public Viewing
	How to Share Your Website Privately
	How to Publish Your Website
	How to Update the Website Each Year with New Data and Archive Old Data



